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1 Released Items

1.1 Documents & Software

File Name Vers Descriptio
ion n
DAVE3_Release Notes v3 1 10 Plugins_Update_2014 05 14.pdf |3.1.10 Release
notes
DAVE3_Update_sites at below location: DAVE 3
1. CE: Update
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/CE 1.0.68 Sites
2. IDE:
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/IDE 1.0.56
3. Debugger:
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/Debugg 1.44.1
er
4, XxSPY: 116
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/XSPY o
5. BMI: 102
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/BMI e
6. GDB Debugger: 1.0.2
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/IFX-GDB

Plug-Ins Versions of DAVE™ v3.1.10 (Plug-Ins Update 2014-05-14)

Installed Software Version Updgte from previous
version

DAVE3 CE 1.0.68.201404090947 Yes
DAVE3 IDE 1.0.56.201405141340 Yes
DAVES Library Manager 1.0.56.201405141340 Yes
DAVE3 MBS XMC4000 1.0.56.201405141340 Yes
DAVES3 Product Branding 1.0.66.201402261436 No
TASKING Debugger for DAVE3 1.44.1.3 No
xSPY 1.1.6.201307151519 No

BMI 1.0.2.201308131243 No
GDB Debugger for DAVE3 1.0.2.201403261508 Yes
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http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/CE
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/IDE
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/Debugger
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/Debugger
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/XSPY
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/BMI
http://dave.infineon.com/Eclipse/Update/Indigo/v3.1.10/IFX-GDB
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2 Support Packages
NA
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3 Tool Information
The following are the tools used for the development and testing.

Tool Name Eclipse
Tool Version Indigo (eclipse 3.7)
JAVA JRE v1.6.0_24.

e JRE is bundled with DAVE.
e Virtual machine configurations are not tested.

Platform Windows Vista, Windows 7, Windows 8.1 — 32bit & 64-bit

Note for windows XP users: Along with the “Windows XP end of support” from Microsoft and
Oracle, DAVE is not tested with windows XP operating system. we recommend to use DAVE
only in supported platforms.

Infineon Technologies 4/21 2014-05-14




Gatineon

DAVE3 Release Notes v3 1 10 Plugins Update 2014 05 14

4 Changes to Previous Version

4.1 Changes from previous version v3.1.10 build 2014-02-26 (Installer Version)

List of Issues Fixed in this release:

Id Feature Description Status
GPDSC file generation is updated to support
41838 DAVES3 IDE seamless import of DAVE projects to keil Fixed
MDK for any step of XMC targets.
GPDSC file generation: change Cclass and .
42097 DAVES IDE Cgroup of predefined Apps (RTOS001) Fixed
Device Description Library not installed with
43033 DAVES3 IDE solver data if older Device Description Fixed
Library versions already installed.
Support of non-XMC device debugging with .
Update IFX GDB SEGGER JLink GDB server. Fixed
4.2 Changes from previous version v3.1.8
New Features Implemented in this release:
Id Feature Description Status
New Debugger GDB Debugger support is added. Supported
New DAVE3 CE GPDSC file genera_tlon based on DAVE Supported
generated source files.
Update DAVES IDE Device support for XMC1000 VQFN devices Supported
Startup file update (3 additional lines in
Update DAVES IDE startup file to be removed) Supported
Update DAVE3 IDE MBS update tp pick linker script template Supported
path from device.xml
List of Issues Fixed in this release:
Id Feature Description Status
30766 DAVE3 CE Solver failure does not stop code generation Fixed
Missing port configuration in
33552 DAVE3 CE MU!_TIPL!EXER.C (when a.Pln, vyh|ch was Fixed
assigned in removed App, is assigned to
newly added App.)
Problems with Examples projects download
33610 DAVE3 CE & import in Library Manager. (white space in Fixed
path issue)
39088 DAVE3 CE Change pf case of a string in a text box is Fixed
not considered.
Infineon Technologies 5/21 2014-05-14
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Multiple entry problems in the link

35054 DAVE3 CE preference (DAVE App/Example Library Fixed
Manager).
Signal Configurator: The target signals are
DAVE3 CE not listed after a selection of one target Fixed
signal and “Solve & Save”.
Other tools and CMSIS related changes:
Id Item Description Status
Update An updated version of ARM® GCC is added.
ARM® GCC New version is 4.7.4 2013q3. Supported
Update New versions of CMSIS device header files,
CMSIS linker script and startup files for the Supported
XMC1000 family.
Update Debugger Sup_port for new VQFN XMC1000 family Supported
Devices.
4.3 Changes from previous version v3.1.6 (Plug-in Update 2013-06-28)
New Features Implemented in this release:
Id Feature Description Status
28593 DAVE3 DAVE Apps version migration feature
- Apps in the project are migrated to latest version Supported
CE : . .
installed in the Library store
24091 ) S )
Device Migration inside the same series
DAVE3 - Project migration support from current device to Supported
CE target device (Only devices of same series PP
including steps are supported)
9870 géVE3 Conditional provided virtual signal Supported
9924 EEVE 3 Minimal version of required apps Supported
14367 géVE3 Resource Reservation Feature Supported
30160 géVE3 DAVE3 Network Configuration default setting "Direct” Supported
16586 DAVE3 Manual resource assignment dialog performance Supported
CE improvements
DAVE3 .
30062 CE Solver timeout default value shall be 15 seconds Supported
19721 géVEL% Add automatically the app version to generated code. Supported
13691 DAVE3 SW App Connectivity view: App Selection shows Supported
CE direct connected apps.
24655 DAVE3 SW App Connectivity view : Preselect latest added Supported
CE app
24656 DAVE3 S_earch function in the S/W App Dependency Tree Supported
CE view
Infineon Technologies 6/21 2014-05-14



https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=9994&acid=56A7DF32C4497F01F7086F103CBBC18D

Gatineon

DAVE3 Release Notes v3 1 10 Plugins Update 2014 05 14

24538 géVEC% aSIIIVV App Dependency Tree view: collapse all, expand Supported
DAVES3 HW Connectivity view: Feature of showing
24275 CE connectivity tree of selected App Supported
DAVE3 Solver execution during App instantiation “Window ->
15466 CE preferences -> Dave -> DAVE CE Preferences” option Supported
15464 DAVE3 Run solver after adding an app without reading back Supported
CE the results.
The default location of the local Library store has
been changed to:
DAVE3 C:\Users\<user_name>\Infineon\D3LibraryStore_3.1.8
New CE This DAVE-3.1.8 version works with only DAVE Apps Updated
library update site v1.0.50 or higher, not with older
versions (see also section 5, Installation
Requirements).
DAVE3 In the MCU target selection page new device steps of
New IDE the XMC4500 series, XMC4400 series, XMC4200 Supported
series and XMC4100 series are added.
DAVE3 The linker script generation for the XC1000 family has
New IDE been modified to support the optimization setting: | Supported
remove unused sections.
List of Issues Fixed in this release:
Id Feature Description Status
29697 DAVE3 CE App selgctor doesn't _show any apps after Fixed
installation of Apps Library
Manual Pin, Signal & Resource Assignment
28667 DAVE3 CE dialog combo box listing issue for big Fixed
projects
28684 XSPY xSF_’Y plug-in: Fix co_nnec'uon_ problems if Fixed
project does not define a variable table
28683 XSPY XSPY plugin: Fix DBG002 version detection Fixed
26024 DAVE3 CE App Selection View inconsistent functionality Fixed
for keywords.
26726 DAVE3 CE Douple P.rOJect download selection and Fixed
confirmation request
29723 DAVE3 CE Opening a_nd cI_osmg CE perspective crash Fixed
app selection view
Other tools and CMSIS related changes:
Id Changed _
ltem Description Status
New An updated version of ARM® GCC has
ARM® GCC been added. New version is 4.7 2013q2. Supported
New New versions of CMSIS device header files
CMSIS for the XMC1000 family and for the
device XMC4400, 4200 and 4100 series. Please Supported
header file refer to the change history of the header
files for details.
Infineon Technologies 7121 2014-05-14



https://secsa010.eu.infineon.com/TargetProcess2/RestUI/TpView.aspx?acid=56A7DF32C4497F01F7086F103CBBC18D#userstory/15466
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26024&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26024&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26726&acid=56A7DF32C4497F01F7086F103CBBC18D
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New CMSIS DSP An updated build of the CMSIS DSP library
library has been added. Supported
New Eclipse CLP, the tool for the resource solver
has been updated to v6.1. As this update is
also related the DAVE App /Device
Eclipse CLP Description library, DAVE v3.1.8 requires Supported
DAVE Apps library update site v1.0.50 or
higher (see also section 5, Installation
Requirements).
New segger GUI A new version of the Segger GUI library has Supported
library been included.
New Installer setup.exe installs DAVE v3.1.8 as
Installer : .
setu new instance and does not remove earlier Supported
P DAVE versions.
4.4 Changes from previous version v3.1.6 (Plug-in Update 2013-05-30)
New Features Implemented in this release:

Id Feature Description Status
27039 DAVE 3 IDE Improved Iog_glng of_networklng problem Supported
during apps installation.

List of Issues Fixed in this release:
Id Feature Description Status
26725 DAVE3 IDE DAVE Apps download fails with Connection Fixed
failed message
Network Connection right after installation to .
26724 DAVE3 IDE download DAVE Apps Fixed
4.5 Changes from previous version v3.1.6 (Plug-in Update 2013-05-10)
New Features Implemented in this release:
Id Feature Description Status
New Eggg 3 Data visualization tool XSPY is added Supported
12205 DAVE 3 CE Support to versioning system. Supported
24608 DAVE 3 CE Solver log: Failure reporting and time. Supported
25421 DAVE 3 CE Solver : Query failure returns all the resources | Supported
New DAVE 3 CE Solver timeout increased to 5 seconds Supported
Infineon Technologies 8/21 2014-05-14



https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26024&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26024&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26726&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=27039&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=27039&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26725&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26725&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26724&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=26724&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=12205&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=25421&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=24608&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=25421&acid=56A7DF32C4497F01F7086F103CBBC18D
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List of Issues Fixed in this release:

Id Feature Description Status
Conditional App Consumption does not work;
3161048 DAVE 3 CE If DAVE is restarted after the Apps Fixed
instantiation.
25687 DAVE 3 CE Apps are not rgmoved from HW connectivity Fixed
when deleted in SW connectivity
25445 DAVE 3 CE Project XML file (config.xml) wrong Fixed
references
25551 DAVE 3 CE ManL_JaI Resource Assignment - Filter is not Fixed
working properly
25609 DAVE 3 CE Solver Timeout value is incorrectly set. Fixed
DAVE 3 CE Wrong instance numbers created at the time Fixed
of app creation
4.6 Changes from previous version v3.1.6 build 2013-02-25 (Installer Version)
New Features Implemented in this release:
Id Feature Description Status
18937 DAVE 3 CE Only one Eclipse Clp process shall be Supported
present.
DAVE 3 CE Provide DAVE App property information on
9881 & IDE right mouse click on the App Supported
Doxygen documentation generation support
9889 DAVE 3 CE for DAVE projects Supported
21834 DAVE 3 CE Logging the time taken for code generation Supported
of templates (all templates logged)
Pin allocator table view: available pin shall
21835 DAVE 3 CE be ordered based on pad number. Supported
When solver fail don't delete the latest
16587 DAVE 3 CE added constraint Supported
(Pin & Signal Connection tool)
List of Issues Fixed in this release:
Id Feature Description Status
23981 DAVE 3 CE No error message when solver fails. Fixed
24443 DAVE 3 CE Sometimes multiple solver eclipse Fixed
processes are found
24646 DAVE 3 CE Wrong deletion of Software connectivity. Fixed
DAVE creates a null eco file in the .
25197 DAVE 3 CE DAVE/eclipse path Fixed
Infineon Technologies 9/21 2014-05-14



https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25687&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25687&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25445&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25445&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25551&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25551&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25609&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=18937&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=18937&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=9881&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=9881&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=13705&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=23981&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=24443&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=24443&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=24646&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25197&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=25197&acid=56A7DF32C4497F01F7086F103CBBC18D
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4.7 Changes from previous version v3.1.4

New Features Implemented in this release:

Issue Id Feature Description Status
Supported All XMC4000 and XMC1000
13705 DAVE 3 IDE Devices. Supported Selecting Device Step Supported
option in new project wizard
Updated Copyright and Licensing
22443 DAVE 3 IDE Information in DAVE3 Help Section Supported
13708 DAVES3 Library Installation speed Improvement for DAVE Supported
Manager App Libraries & Example Projects P
Preprocessor define ‘DAVE_CE’ for compiler
21535 DAVE 3 CE & assembler is added for all DAVE Code Supported
Engine Projects
Preprocessor define ‘UC_ID=SW _ID’ for
21336 DAVE 3 CE compiler & assembler is added for all Supported
DAVE Projects
DAVE 3 CE Signal Connection Dialog User interface Supported
21932 o ; )
Usability Improved for Big Projects
Manual Pin Assignment User interface
15524 DAVE 3 CE Usability Improved for Big Projects Supported
21831 DAVE 3 CE Updated DAVE User Manual Supported
DAVE3 Tool & Apps Error Reporting:
15603 DAVE 3 CE In problem view user messages are Supported
reported. In workspace .log file all
messages are logged
19529 DAVE 3 CE All solver query timeouts changed to 1 sec. Supported
15439 DAVE 3 CE Faster processing of solver results Supported
DAVE Application model optimization for
17465 DAVE 3 CE Speed & size Supported
Code Generation speed improvement.
13631 DAVE 3 CE Further speed |mprov_ement in CO(_je Supported
regeneration by caching template java
classes.
13637 DAVE 3 CE Option in DAVE menu to clear cached code Supported
generator template java classes
DAVE 3 CE Code Generation: Delete only generated Supported
15599 files during re-generation process ( speed
improvement)
DB-124 DAVE3 MBS Added XMC1000 support to MBS Supported
DB-129 DAVE3 MBS Upd_ate linker script templates XMC1000 Supported
family
DB-130 DAVE3 MBS Add support for the ARM GNU print size tool | Supported
DAVE3 MBS Replaced the tool reference from XMC4000 Supported
DB-131 to XMC, since support for the XMC1000 is
added as well
Infineon Technologies 10/21 2014-05-14



https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=13705&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=13705&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=13705&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=22443&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=21535&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=21535&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=21932&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/Planning/UserStory/View.aspx?UserStoryID=21831&acid=56A7DF32C4497F01F7086F103CBBC18D
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DB-135 DAVE3 MBS A_dded common CMSIS Infineon Include and Supported
Lib paths
DB-124 Tasking A'dded XMC1000 debugger support with J- Supported
Debugger Link
DB-139 Tasking Updated XML SFR files of XMC4000 Family | Supported
Debugger
DB-141 Tasking Added support for Boot Kit for XMC1100, Supported
Debugger XMC1200 and XMC1300
DB-142 Tasking Added support for XMC1100, XMC1200 and Supported
Debugger XMC1300 devices
DB-143 Tasking Added support for XMC4100 devices Supported
Debugger
List of Issues Fixed in this release:
Id Feature Description Status
20242 DAVE 3 CE Code Generation Issue: Some files are not Fixed
generated.
App defined Project Include Paths: App
21985 DAVE 3 CE defined Include path are not added again if Fixed
manually removed by user
19976 DAVE 3 CE S/W Ap|_o Connectivity View: SW depend_ency Fixed
connections are not shown for some projects
22624 DAVE 3 CE User added project include paths are Fixed
removed after code generation.
DAVE Support app not added in a new
20238 DAVE 3 CE project which results in compilation issue. Fixed
DAVE 3 CE Error message not displayed incase device Fixed
18867 descriptions are missing for selected device
during project creation
DAVE 3 CE In big project having many apps unable to Fixed
17042 . ;
select pin allocation
DAVE 3 Incomplete download/update of App & Fixed
17794 Library . : .
M example projects & library store corruption
anager
Tasking Debugger crashes now and then after a re- Fixed
DB-128
Debugger launch
Tasking Debugger cannot reload ELF file while target Fixed
DB-132 . >
Debugger is running
Infineon Technologies 11/21 2014-05-14



https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=20242&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=20242&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=21985&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=19976&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=19976&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=22624&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=22624&acid=56A7DF32C4497F01F7086F103CBBC18D
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=20238&acid=A55F92DAFB0603D78FCA02B3DBB657EA
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=20238&acid=A55F92DAFB0603D78FCA02B3DBB657EA
https://secsa010.eu.infineon.com/TargetProcess2/Project/QA/Bug/View.aspx?BugID=17794&acid=A55F92DAFB0603D78FCA02B3DBB657EA
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4.8 Changes from previous version v3.1.2

New Features Implemented in this release:

Issue Id Feature Description Status
12196 DAVE 3 CE Manual Resource reservation & allocation Implemented
support
9895 DAVE 3 CE HW Conneptmty & SW Dependency as Implemented
separate views.
New DAVE 3 IDE C++ Support Implemented
New DAVE 3 IDE Enable CCACHE to speed up re-compilation | Implemented
Code generation provides following options,
In case of no changes in configuration,
e Cancel code generation
15681 DAVE 3 CE e Solve and re-generate code Supported
e re-generate code without invoking
solver
AlI00067859 DAVE 3 CE Updates availability check shall be by default Supported
enabled
Support for DAVE Apps to include or
AlO0073327 DAVE 3 CE exclude Library from build conditionally. Supported
List of Issues Fixed in this release:
Id Feature Description Status
Al00066224 DAVE 3 CE DAVE 3 Code Generation affecting MBS Fixed
every time
AI00067495 DAVE 3 CE DAVE Ap_p Ul : White background for Fixed
enabled fields in
AI00066216 DAVE 3 CE DAV_E CE Perspective Search option is Fixed
missing
12195 DAVE 3 CE Deleting of required apps based on the User Fixed
preference
12196 DAVE 3 CE Manual p|n.as_5|gnme_n.t:_ include previous Fixed
pin constraint in feasibility query
12203 DAVE 3 CE App tree view: multiple selection of top Apps Fixed
12371 DAVE 3 CE Add to help menu direct link to Dave Forum Fixed
12187 DAVE 3 CE Manual Pin ASS|gnmer_1t_V|eW :all pad Fixed
resources should be visible.
12189 DAVE 3 CE Avoid need of a windows environment Fixed
variable (ECLIPSEDIR) for the solver
12198 DAVE 3 CE Cancel button during code generation. Fixed
Warning message to be shown for Apps
12176 DAVE 3 CE which are not able to be instantiated due to Fixed
SWID Missing, App not Installed..
Removal of previous constraint is not .
15031 DAVE 3 CE considered in the Manual Pin Assignment Fixed
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17150 DAVE 3 IDE GUI Active page refreshment after solver Fixed
run
4.9 Changes from previous version v3.1.0
New Features Implemented in this release:
Issue Id Feature Description Status
AlI00065680 e Function to import an example project
App Proiect from the local library
Irr?gort ] e Check for DAVE App Updates & Supported
“Uninstall DAVE App/Example Library” as
separate menu items in Help Menu
Al00065585 Manual Pin “Solve & Save” Functionality added in place | Supported
Mapping of “Save”
Al00064965 Signal Signal connectivity Ul enhancement: output
Connection signals only need to be displayed in the third Supported
ul column
Al00066032 Report tSarg)arrcxble & Singleton fields in Report ->Apps Supported
New Feature emwin Segger™ emWin GUI library is provided in
Library the DAVE™ 3 Installation folder Supported
List of Issues Fixed in this release:
Id Feature Description Status
Issue 1 Build error ("The input line is too long”) when
the project contain many source files. Eclipse | .
IDE & MBS CDT Bugzilla Issue. (CDT Patch for this issue Fixed
available)
Issue 2 CMSIS Folder | Start-up files update with doxygen comments | Fixed
Al00067291 A App dependency view is not updated after
bp close /reopen project workspace (condition | Fixed
Dependency .
App consumption feature)
Issue 3 Import project feature is not working for some
Project Import | DAVE v3.1.0 created projects Fixed
AI00066365 Device description peripheral version
gﬁvigﬂi & changes are incorrectly handled in DAVE Fixed
PP PP MS & Support App.
Al00066305 Signal Dave 3.1.2: Signal Connection dialog: “Solve & | _.
; " . Fixed
Connection Save” successfully but no connection.
Issue 4 JSianal lists all the connections defined in Manifest
Repor Signa even for conditional connections Fixed
Assignment
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MCSW300000211 | DAVE 3 Help | Change writing style of DAVE 3 in Help menu Fixed
Menu and in About DAVE 3
AI00065666 DAVE3 Apps | Error message when User Interface | _.
Fixed
ul parameters overflow/underflow
AI00065517 App Error: when required App have different | _.
o ) . . Fixed
Dependency version in project and in the repository
AI00065293 Project copy- | Project paths when copy-paste/rename Fixed
paste/rename performed by user
Issue 5 In the memory view it is not possible to | _.
Debugger change the content of SFR registers. Fixed
Issue 6 Debugger Project with high optimizations cannot be Fixed
downloaded
Issue 7 In SFR View:
e In a Register array only the first )
Debugger element is shown Fixed
e Some registers for e.g. EXICON and
EXOCON registers are missing
Issue 8 Device Multiple versions of Device Description | _.
Description Installati . tiv handled Fixed
Installation nstallation were incorrectly handled.
List of Known Issues:
o refer section 6
Infineon Technologies 14/21 2014-05-14




o
Infineon
DAVE3 Release Notes v3 1 10 Plugins Update 2014 05 14

5 Installation Requirements

« As per Instructions provided during DAVE ™ 3 Installer.

e Starting with DAVE-3.1.8, maintaining parallel installations of DAVE is
supported.

Please refer the Installation procedure for the details.
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6 List of known Issues

Module Fault Id Description Work Around
DAVE Known DAVE Example
Example Issue projects import
projects showing Select one project -> right click & select “Set
import multiple projects Active Project” setting.
getting active in
some cases.
DAVE Known Refresh of
Project Issue project is
Managem necessary
ent before . .
deleting/renami Refresh Project (File ->Refresh)
ng/paste a
project
App Known Apps Library
Library Issue Un-installation This is observed only in one-off cases. No
Uninstalla removes the L
; ; workaround for this issue
tion Library, not the
Apps
App Known Un-Install
Library Issue Libraries dialog
Uninstalla goes blank after This is observed only in one-off cases. No
tion Apps Library workaround for this issue
Installation/Un-
Installation
App Known Library Store
Library Issue Software Id
Installatio index file is
n corrupted after This is observed only in one-off cases.
Apps Library Workaround is to create new Library store &
updates. No refer this in DAVE preferences
Apps are shown
in App selection
view.
App Known DAVE Apps
Library Issue download fails .
Installatio with Connection Workaround: Retry Download/Update of Apps
n failed message

Infineon Technologies
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Network Known In some networks eclipse will prompt
configurat Issue connection problems. In this case change the
ion connection preferences as shown below:

1. Click “Window” , “Preferences”, >General
>Network Connections
2. Active Provider set as “Native”

Network Retry Installation of DAVE Apps/Example
configuration Projects
right after

installation to
download DAVE or

Apps
Download the DAVE App Libraries zip file and
Install from local path.
DAVE App Libraries Link
Tasking Known Debugger
Debugger Issue unable to start
for below
scenario :

A Project that
has a reference
to a linked folder No workaround ( Eclipse Platform Issue)
and when
creating the link
the option
"Create virtual
folders" is
checked

DAVE Known During Device
Migration Issue Migration, There
may be an pop- This is observed only in one-off cases.
up message Workaround is to run solver / do Device
about the Migration again.

Resource
mapping failure.
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6.1 DAVE Migration feature

6.1.1 Apps Migration — 10002 Pad Speed class inclusion in solver query
Problem Description:

The old version of the 10002 Apps has the pad speed class selection with Al as default and the
selection was not included for the solver query. However, the new version includes the pad speed
class selection to the solver query. This may lead to solver error condition.

Example: Apps which consumes 10 Apps, like CAN Examples, Motor control Examples (latest
published examples)

How to solve the solver error with pad speed class?
User should review 10002 App to change the pad class selection to appropriate class type which is
supported by the device. The Pad Speed Class selection Ul control is shown below,

Pad Class

Dont Care -

Dont Care
L M+

A2

Al

This will solve the issue for the IO Apps which has the output mode configured.

6.1.2 Device Migration — The selected Target device doesn’t have user-assigned pins
Problem Description:

Device Migration will report when the user-assigned port pins are not available in the selected Target
device.

How to change the project to migrate to selected device?

User should review the user-defined configurations such as Manual PIN Assignment and Hardware
Resource Assignment dialogs and then update it to “Not selected” and do Solve & Save. This will help
the solver to assign the available resource in the selected device.

6.1.3 Apps Migration — Library ordering for Linker
Problem Description:

As the Apps Migration creates the new version of the Apps, copy the values and generates the code,
The Library ordering for linker need to be taken care as like new project creation with Library inclusion
from the Apps.

How to avoid the build errors due to the library ordering change?

User should review “Active Project Settings > Tool Settings >ARM-GCC C Linker > Libraries”, and
then change desired order manually as explained in the Apps help document.

6.1.4 Apps Migration — Required App changed from 10002 - 10004
Problem Description:

The version increment of App changes the required App from 10002 to 10004. The Apps Migration will
report it as missing App in the new version and will instantiate the new Apps with default values as
required by new version of the top level App.
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How to get the working state of the project?
User should take care of configuring the new App with desired values.

6.1.5 Apps Migration — Ul data copy: Ul Difference
Problem Description:

As the Apps Migration creates the new version of the Apps, copies the values and generates the
code, Ul value copied from old version to new version may be incorrect for some cases like
parameter-to-parameter dependency.

How to correct the Ul value?
User can review and change it to the required value as in the original project.

6.1.6 Apps Migration — Apps increment with API signature change
Problem Description:

There is some Apps update with a change in provided APIs, The Apps Migration will give the error if
the project used the APIs in the Application code.

How to correct the build error?
User should review the application code and modify the API calls accordingly.
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7 Violations

NA

Infineon Technologies 20/21 2014-05-14



o
Infineon
DAVE3 Release Notes v3 1 10 Plugins Update 2014 05 14

8 List of Limitations and Deviations

The following table summarizes the most important limitations and deviations with respect to the
Specification.

Module Limitation / Deviation
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